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Hi!
Get ready to explore the 

exciting world of technology and 
computer science. Together, we’ll dive into 
new skills, discover creative ways to solve 

problems, and build awesome projects. 
Grab your curiosity and let’s get 

started!
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An innovative approach to building digital competencies, developed by 
expert educators.

Curriculum aligns with the latest industry standards, preparing students for 
certifi cations and future careers.

Well-defi ned learning goals and hands-on, applicable digital skills.

Key Features

Each unit o�ers 
straightforward explanations 

and contemporary 
examples, making 

technology concepts 
accessible and relevant.

Every unit includes a variety of 
tasks and activities designed to 

help students build essential 
digital competencies.

Students learn about platform 
diversity, expanding their 

digital toolkit and adaptability.

Projects and exercises 
throughout the course reinforce 

students’ understanding and 
practical application of digital 
skills in real-world scenarios.

Each unit organizes key terms 
that are crucial for digital 

literacy, equipping students 
for today’s technology-driven 

workplace.
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1. �Collecting 
information

Data is all around us, and knowing how to organize and make 
sense of it can help you in school, work, and everyday life. This 
unit covers how to create and use a simple database, sort and 
filter information, work with percentages and powers, use 
formulas with references, and create charts to make data clear 
and understandable.

Learning Objectives
In this unit, you will:
>	 identify what data and information are, and how they are different.
>	 create a simple database with fields to organize information.
>	 identify how computers use the binary system to represent data.
>	 identify what the ASCII character set is.
>	 apply filters or custom filters to show only specific records that meet 

your needs.
>	 sort data including multi-level sorting to organize by more than one 

field.
>	 import and export data as a CSV file.
>	 calculate percentages and powers.
>	 use relative and absolute cell references in spreadsheet formulas.
>	 recognize, troubleshoot, and fix common spreadsheet errors.
>	 identify the types of charts you can use in Excel.
>	 create different charts and add titles, labels, and colors.
>	 use conditional formatting to highlight important numbers in your data.
>	 add mini charts to show trends in your data.
>	 identify how a data logging software can display the data as a chart.

Tools
>	 Microsoft Excel

6 For Review Purposes Only 



Data is facts or details that are collected but not processed or organized yet. For example, a list of 
numbers or names is data. Information, on the other hand, refers to the organized or processed 
form of data that is meaningful or useful. For instance, when data is sorted or explained, it becomes 
information. 

Types of data
Data is usually in the form of text, numbers, and symbols, and sometimes it may be in the form of 
images, videos, and sounds. You will now learn about some types of data.

Numerical data: Numerical data contains measurable facts. Examples of numerical data include the 
number of visitors to a museum, the number of cars passing through a toll booth, and a student’s 
test scores in various subjects. 

Alphabetic data: Alphabetic data consists of all the letters of the alphabet and spaces used to 
separate words. Examples of alphabetic data include product names, street addresses, and names.

Alphanumeric data: This type of data includes all alphabetic characters, numbers, and special 
symbols such as #, $, %, etc. Examples of alphanumeric data include tracking codes like A12345, 
product identifiers such as XTR56A, and student IDs like S00123. These combinations of letters and 
numbers help organize and identify items efficiently across different systems.

Turning data into 
information
Computers are powerful tools that transform 
raw data into meaningful information. They 
take input from sources like keyboards or 
sensors, process it through calculations or 
sorting, and generate organized output.

For example, they can analyze temperature 
readings to produce a clear weather report.

LESSON 1

Introduction to databases

Have you ever wondered how your school keeps track of attendance, 
or how a library knows which books are available or checked out?

Input

Processing

Output
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Data representations
Computers work by handling data in different ways. However, they can only understand data as 
binary digits, which are just 0s and 1s. This means we need to change many types of data, like 
numbers, text, pictures, and videos, into binary format so computers can store and use them. 

Representing numbers
For numbers, computers use the binary system to represent positive whole numbers (like 1, 2, 3).  
But when we need to work with negative numbers or decimal numbers (like -5 or 3.14), there are 
other special methods to represent these numbers using just 0s and 1s.

Representing text
To represent text (like letters and symbols) in computers, we use something called character sets.  
A character set is a list that matches each letter, number, or symbol with a specific binary code. One 
of the most common character sets is called ASCII (which stands for American Standard Code for 
Information Interchange).

Dec Hex Char Action (if 
non-printing) Dec Hex Char Dec Hex Char Dec Hex Char

0 0 NUL (null) 32 20 Space 64 40 @ 96 60 `

1 1 SOH (start of heading) 33 21 ! 65 41 A 97 61 a

2 2 STX (start of text) 34 22 " 66 42 B 98 62 b

3 3 ETX (end of text) 35 23 # 67 43 C 99 63 c

4 4 EOT
(end of 
transmission)

36 24 $ 68 44 D 100 64 d

5 5 ENQ (enquiry) 37 25 % 69 45 E 101 65 e

6 6 ACK (acknowledge) 38 26 & 70 46 F 102 66 f

7 7 BEL (bell) 39 27 ' 71 47 G 103 67 g

8 8 BS (backspace) 40 28 ( 72 48 H 104 68 h

9 9 HT (horizontal tab) 41 29 ) 73 49 I 105 69 i

10 A LF
(NL linefeed, new 
line)

42 2A * 74 4A J 106 6A j

11 B VT (vertical tab) 43 2B + 75 4B K 107 6B k

12 C FF
(NP linefeed, new 
page)

44 2C , 76 4C L 108 6C l

The hexadecimal value of the 
character. Hexadecimal is a 
base-16 numbering system.

The decimal value of the character. 
Decimal is a base-10 numbering system 

(the system we commonly use). 

The actual character 
or symbol represented 

by the ASCII code.

ASCII character set
In the ASCII character set, each letter, number, or symbol has its own binary code. For example,  
the letter 'A' is represented by the number 65, and the letter 'a' is represented by the number 97. 
Computers use these codes to understand and display text.

However, the first 32 characters in ASCII are special. They don’t represent letters or numbers that 
you can print on the screen. These characters are used for things like the Enter key or the Tab key 
on your keyboard.
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13 D CR (carriage return) 45 2D - 77 4D M 109 6D m

14 E SO (shift out) 46 2E . 78 4E N 110 6E n

15 F SI (shift in) 47 2F / 79 4F O 111 6F o

16 10 DLE (data link escape) 48 30 0 80 50 P 112 70 p

17 11 DC1 (device control 1) 49 31 1 81 51 Q 113 71 q

18 12 DC2 (device control 2) 50 32 2 82 52 R 114 72 r

19 13 DC3 (device control 3) 51 33 3 83 53 S 115 73 s

20 14 DC4 (device control 4) 52 34 4 84 54 T 116 74 t

21 15 NAK
(negative 
acknowledge)

53 35 5 85 55 U 117 75 u

22 16 SYN (synchronous idle) 54 36 6 86 56 V 118 76 v

23 17 ETB
(end of trans. 
block)

55 37 7 87 57 W 119 77 w

24 18 CAN (cancel) 56 38 8 88 58 X 120 78 x

25 19 EM (end of medium) 57 39 9 89 59 Y 121 79 y

26 1A SUB (substitute) 58 3A : 90 5A Z 122 7A z

27 1B ESC (escape) 59 3B ; 91 5B [ 123 7B {

28 1C FS (file separator) 60 3C < 92 5C \ 124 7C |

29 1D GS (group separator) 61 3D = 93 5D ] 125 7D }

30 1E RS (record separator) 62 3E > 94 5E ^ 126 7E ~

31 1F US (unit separator) 63 3F ? 95 5F _ 127 7F DEL

What is a database?
Now that you know how data is turned into information and how computers store and use data, let’s 
examine databases in more detail. A database is a tool that helps us organize and manage large 
amounts of data, like a school keeping track of student grades or a library keeping records of 
borrowed books. Databases use tables with rows and columns to neatly store information, making it 
simple to find, update, and analyze. You will learn how to create a simple database using tools like 
Microsoft Excel and explore how fields (columns) and records (rows) work together to organize data.

In the address book database, 
each record has four fields:

1. Name

2. Home address

3. Phone number

4. Email address

1. Name

Lisa

2. Home address

36 Cambridge Court

3. phone number

212 500 2020

4. email address

lisa.bacademy@outlook.com
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Name Address Phone Number Email Address

Kim 22 Alfred Drive 212 500 4412 kim@digital-kids.com

Marco 44 Woodrow Way 212 500 4321 Marco@digital-kids.com

Lisa 36 Cambridge Court 212 500 2020 lisa@digital-kids.com

Alex 202 Newport Lane 212 500 5162 alex@digital-kids.com

Teachers

Name Home Address Phone Number Email Address

Kim 22 Alfred Drive 212 500 4412 kim.bacademy@outlook.com

Marco 44 Woodrow Way 212 500 4321 marco.bacademy@outlook.com

Lisa 36 Cambridge Court 212 500 2020 lisa.bacademy@outlook.com

Alex 202 Newport Lane 212 500 5162 alex.bacademy@outlook.com

Students

A record in a database is a single, 
complete set of related data within a 
table. It is represented as a row in the 
table and contains all the information 

about a specific item, person, or event.

Every specific category of 
information is called a field. A 

field is represented as a column 
in the table and stores one type 

of data for all the records.

Why use databases?
Databases are useful for storing, searching, and updating large amounts of data efficiently. Imagine 
trying to keep track of all students’ grades in your school without a database. It would take much 
longer to organize and find the right information. With a database, you can:

• Save all your data in one organized place.

• Quickly find specific information (for example, all students who scored above 90%).

• Add new information or change existing details (for example, update a student’s grade).

Databases can be used in various tasks in everyday life, such as tracking purchases in online 
shopping, storing patient information in health care, organizing books in libraries, handling financial 
transactions in banking, and personalizing content on social media and streaming platforms.

History
Edgar F. "Ted" Codd was an English computer scientist who invented the relational model for 
database management in 1970 while working for IBM. His theory is the basis for relational 
databases and data management.

A database table is like a structured container that 
holds related information, such as names, 

addresses, or grades, and organizes them into rows 
(horizontal) and columns (vertical), making it easier 

to search and analyze the data to obtain information.
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Create a database
Now it’s time to create your own database. The first thing you have to do is decide what kind of 
information you want to include. Think of the characteristics you want to collect for each record and 
give them a title or a field name. Although there are various programs for database management, 
you can use Microsoft Excel to create your database table.

Let’s create an address book database of your friends’ information.
The field names are: Name, Telephone, Home Address, Email Address, Birthday, Hobby.

4

To create a database:

> Open a new worksheet.
> Type the database field names horizontally in different cells (from A1 to F1). 1

> Select A1 to F1. 2

> Click the Bold button 3  to make the titles stand out.
> Now add one record for each of your friends. Every record must have 

information about the six different fields displayed here. 4

1

2

3
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To apply a table style:

> Select your table cells from A1 to F7. 1

> On the Home tab, in the Styles group, click Format as Table. 2

> Select a style, e.g., from the Medium group. 3

> In the Create Table window, select My table has headers. 4

> Click OK. 5

> Your table has a new style, and the program knows that the 
titles are field headers. 6

All the information in a 
database must relate to 

the same topic. For 
example, you cannot have 
information about sports 
in an animal database.

Format as table
Now that your database information is ready, it’s time to format it so Microsoft Excel recognizes it as 
a data table. Choose a style that makes your data clear and ensures it is ready for analysis.

1

2

3
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5

4

6

If you want to add another friend 
later, you can simply start typing the 
new information on the first empty 
row under the data, and Microsoft 

Excel will recognize it as a new 
record and include it in the table.
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1. Read the questions and put a check mark for the correct answer.

1. What is a field in a database?

 a. A row of data

 b. A type of record

 c. A column that stores one type of data

 d. A whole table

2. Which of the following is an example of alphabetic data?

 a. 12345

 b. A12345

 c. John Doe

 d. $%&

3. What does the ASCII character set do?

 a. It processes binary numbers into text.

 b. It assigns a binary code to each letter, number, or symbol.

 c. It organizes large amounts of data into databases.

 d. It helps format Excel tables.

4. What is the purpose of formatting data as a table in Excel?

 a. To make it more polished

 b. To make data clear to read and analyze

 c. To change data into text

 d. To remove information

5. What is a record in a database?

 a. A row in a table that contains all the information about a single entity.

 b. A column in a table that categorizes data.

 c. A binary code for representing characters.

 d. A header row of a table.

14

Hands on!
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2.	 Complete with the missing words.

numerical field data record

1.	 �A database is a collection of  that can be organized, sorted, 

and searched.

2.	 �In a database, a  represents one row of information about a 

person or item.

3.	 �The  data includes measurable facts like test scores or visitor 

numbers.

4.	 �A  is a column in a database table that holds one type of 

information.

3.	 Why do you think it’s essential to use a database in a school to manage student 
information, such as grades, attendance, and contact details? Ηow does it help teachers 
and administrators efficiently update, search, and generate reports from this data? What 
problems might arise by inserting incorrect fields?

4.	 Create a database about music.

Choose your favorite music artist or band and search the Web for their discography.
A discography contains information about all the albums an artist or band has ever released. 
Create a database in Microsoft Excel that includes the following fields: Album Title, Date 
Released, Top Chart Position, Albums Sold. Finally, format your database as a table.

15For Review Purposes Only 



1.
  C

o
ll

ec
ti

n
g

 i
n

fo
rm

at
io

n

Filter and sort
After you create a database table, you can use filters and sorting to organize and find information 
quickly. Filters help you display only the data you need, like specific names or numbers, while 
sorting puts the data in order, such as from smallest to largest or A to Z.

To filter and sort data:

> Click the column header arrow on the Name header. 1

> Apply a filter by selecting only the names you want to 
display, 2  and click OK. 3  Only the selected records will be 
displayed in the spreadsheet. 4

> The column header arrow 5  of the field header will change to 
indicate that a filter has been applied to the specific records.

> Click the column header arrow on the Name header again. 6

> Click Sort A to Z to sort the specific records alphabetically. 7

> The set of records will automatically change position in the 
table and will now be sorted based on the Name field. 8

> The column header arrow 9  of the field header will also 
change to show that the table is displayed in a specific order.

1

2

3

LESSON 2

Filter and sort

Have you ever needed to find something specific in 
an extensive list? What could you do to find it quickly, 
and how would you decide where to start searching?

4
5
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9

6

Multi-level sorting
Sometimes it’s useful to sort your 
database data according to multiple 
fields instead of just one. This is 
called multi-level sorting, and it 
works like this:

Let’s say you want to sort your data 
alphabetically by hobby and then by 
name. This means that all your 
records will be sorted by hobby, and 
if some of those records happen to 
have the same hobby, they will be 
sorted again by name.

To apply multi-level sorting:

> Select your table cells from A1 to F8. 1

> On the Home tab, in the Editing group, click Sort & 
Filter 2  and then Custom Sort. 3

> In the Sort by list, click Hobby. 4

> Click Add Level 5  to add a second level of sorting to 
your data. A new row will be displayed.

> In the Then by list, click Name. 6

> Click OK. 7

> All records will be sorted based on the Hobby field 8

and then based on the Name field. 9

1

8

2

3

If you have already sorted a field, such as the Name field mentioned in the previous 
example, you can click the Undo button to go back and work with the unsorted data.
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Smart Tip
Sorting is an effective method for organizing your data in any program that supports it. When 
data is sorted, it becomes much easier to find the information you need.

4

5

7

The arrow buttons of the field headers will change to 
show that the table is displayed in a specific order.

89

6

Notice that the names of those who like 
photography are arranged alphabetically.

Try sorting the database table using other fields, 
like Telephone, and check the results.
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To apply a custom filter:

> Click the column header arrow next to a field header, in this example, Birthday. 1

> Click Text Filters, 2  and then click Contains. 3

> In the Custom AutoFilter window, in the text box, type "April". 4

> Click OK. 5

> As a result, only records with the word "April" in the Birthday field are displayed. 6

Custom filters
Now let’s explore some more advanced filters. Let’s display only the records of people whose 
birthdays are in April.

4

5

Notice the options in the 
drop-down list. The filter 

names are self-explanatory.

You can try out different filters to 
check what effect they have. You 

can also apply another filter in 
another field of your database 
right after the last one, to filter 

your records even more.

1

2

3

There are many other filters apart from 
“Contains” that you can use, depending 

on what you want to display.

19For Review Purposes Only 



1.
  C

o
ll

ec
ti

n
g

 i
n

fo
rm

at
io

n

6

Can you apply a custom filter to show the records of 
people whose birthday is on the 17th of any month?

To export data from Microsoft Excel to a CSV file:

> Click the File tab. 1

> Click Save As and then click Browse. 2  The Save As window will open. 3

> Choose the folder where you want your file to be saved. 4

> Type a name for your file in the File name text box. 5

> In the Save as type list, click CSV (Comma delimited). 6

> Click Save. 7  A new CSV file has been created. 8

Exporting data
Sometimes, data created in Microsoft Excel needs to be stored in a format that can be interpreted by 
other applications. This can be done by exporting the data to a CSV (Comma-Separated Values) 
text file. 

A Comma-Separated Values (CSV) text file is a simple file format that is widely used by scientists and 
businessmen. As its name suggests, the values in each row of data are separated by commas or 
tabs. CSV text files are simple but important. A CSV file is a simple text file with no format. The data 
is stored as a sequence of characters. This way, the file is relatively small in size, even though it can 
hold a large amount of data.

Consider the worksheet below:
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3

8

6
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Importing data
It is also possible to import data from a CSV text file into an existing or a new Microsoft Excel 
worksheet. This is helpful because data can be formatted and analyzed. Open a new spreadsheet. 

Import data from a CSV file:

> On the Data tab, in the Get & Transform Data group, click From Text/CSV. 1

> Locate and choose the text file you want, e.g., click Contacts_book. 2

> Click Import. 3

> The Contacts_book.csv window will open. 4

> Click Load to import a delimited file in a new worksheet. 5

> The data has been entered in the spreadsheet as a table. 6

1

2

3
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Delimiter defines the 
character that separates 
values in your text file.

When you import a CSV text 
file, it is automatically 
converted to a table.
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1. Read the following sentences and put a check mark for True or False.

True False

1. Applying a filter is useful for checking only a specific set of 
records from a large table. 

2. Data for text fields can be sorted alphabetically, but there is 
no way for numerical data to be sorted. 

3. Multi-level sorting allows you to sort data by more than one 
field. 

4. Custom filters allow you to display records based on specific 
conditions, such as dates or numbers. 

5. Sorting data is unnecessary if the data is arranged randomly 
in your table. 

6. In Microsoft Excel, you cannot import data from a CSV file.

7. In a CSV file, values in each row of data are separated by a 
comma or a tab.

2. Complete with the missing words.

multi-level filter sort custom contains table

1.  Applying a , allows you to display only a specific set of data 

records in a large table.

24
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2.	 �A filter that only shows records containing a specific word or phrase uses the 

 filter option.

3.	 �To display only the records of people whose birthday is in April, you would use a 

 filter.

4.	 �A  is used to organize your data in alphabetical or numerical 

order, making it simple to find information.

5.	 Sorting data by more than one field is called  sorting.

6.	 When you import a CSV file, it is automatically converted to a . 

3.	 Why is it important to use filters when working with a large dataset, and how can it help 
save time? In what situations might sorting data by multiple fields be more beneficial than 
sorting it by just one field?

4.	 Create a new music database with fields such as Artist Name, Album Title, Genre, and 
Release Date. Once the database is set up, sort the records based on the Release Date 
field, arranging them from oldest to newest. After sorting, filter the Release Date field to 
check if any albums were released the year you were born. If no records match, apply 
another filter to check if any albums were released on your birthday, ignoring the year. 
Finally, export your database table to a CSV text file.
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Working with databases and spreadsheet tables in Excel helps you organize, sort, and filter data to 
quickly find specific information. Now, let’s talk about an important step in working with data, which 
is "data cleaning." Data cleaning means improving the accuracy of data by fixing errors or filling in 
missing information.

To remove duplicate values from a data table:

> Select the range of cells in your table from which you want to remove duplicates, 
e.g., cells A2 to C7. 1

> In the Data tab, in the Data Tools group, click Remove Duplicates. 2

> The Remove Duplicates window opens. Select the column from which the 
duplicates will be removed 3  and click OK. 4

> A window pops up to inform you about duplicates removed and unique data 
remaining. Click OK. 5

> Your table or range of cells now has unique data values. 6

LESSON 3

Making complex calculations

Are there any circumstances under which we need to change 
the format of a number or separate characters from a text?

Removing duplicates
When working with data, you might notice that some entries are repeated. These are called 
duplicates, and they can cause problems by making your data inaccurate or messy. Removing 
duplicates is an important part of data cleaning. 

An institution of your city has conducted research to find out how much of each country is covered 
by Internet signals. Create the following table:
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To change a number to a percentage:

> Click on cell D3, type "=C3/B3", 1  and press . 2

> Use the AutoFill tool to copy the formula to cells D4 to D6. 3

> Select the cells that contain the numbers you want to format, in this case, cells D3 to D6. 4

> On the Home tab, in the Number group, click the Expand button. 5

> In the Format Cells window, click the Number tab. 6

> In the Category list, click Percentage. 7

> Type a number in the Decimal places text box, e.g., "2". 8

> Click OK. 9

> The numbers in cells D3 to D6 are now shown as percentages. 10

Working with percentages
Working with percentages can be difficult at first, but with practice, it becomes easier. To change a 
decimal number to a percentage, apply the percentage format. Microsoft Excel multiplies the value 
in the cell by 100 and displays the result with a percentage sign.

1

2
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You can also apply 
the percentage 

format by clicking the 
Percent Style button 
in the Number group 

of the Home tab.

3

4

5

6

7
8

9

10
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Calculating powers
Calculating powers in Excel allows you to raise a number to a specific exponent. The process uses 
the caret (^) symbol or the POWER function for flexibility and precision.

Create the following table:

To calculate powers:

> Click on cell C2. 1

> In the Formula bar, type "=A2^B2". 2

>  Press  +  to calculate the 
formula and stay in the same cell. 3

>  Use the AutoFill tool to copy the formula 
to cells C3 and C4. 4

1

2

3
4

You can use the function POWER(x,y) 
instead of using the ^ symbol. Depending on 
Regional settings, Microsoft Excel functions 
are written with a semicolon between the 

Function Arguments e.g., POWER(x;y).

The LEFT function
In computational language, data that is represented as text is called a string. If you want to extract a 
part of a strong, called a substring, from the left side, use the LEFT function.

To use the LEFT function:

> Click in cell B3. 1

> On the Formulas tab, in the Function Library group, click Text. 2

> In the list, click LEFT. 3

> In the Function Arguments window, in the Text box, type "A3". 4  It’s the cell 
from which you are going to extract characters.

> In the Num_chars text box, type "4". 5  You are specifying how many 
characters you want to extract from the left side of the text. 

> Click OK. 6

> The result of the function is displayed in cell B3. 7
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4

5

6

3

Type the following data:

7

Try to extract Lisa's 
name from cell A4.
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To use the MID function:

> Click in cell C3. 1

> On the Formulas tab, in the Function Library group, click Text. 2

> In the list, click MID. 3

> In the Function Arguments window, in the Text box, type "A3". 4

It’s the cell from which you are going to extract characters.
> In the Start_num text box, type "24". 5  It’s the position of the 

first character you want to extract.
> In the Num_chars text box, type "12". 6  You are specifying how 

many characters you want to extract. 
> Click OK. 7

> The result of the function is displayed in cell C3. 8

The MID function
Let's extract characters from the middle of a text string (substring). Εxtract Alex's email from cell A3. 
To do that, use the MID function. 

1

2

4

5

6

7

8

Try to extract Lisa's 
phone number 
from cell A4.

3
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To use the RIGHT function:

> Click in cell D3. 1

> On the Formulas tab, in the Function Library group, click Text. 2

> In the list, click RIGHT. 3

> In the Function Arguments window, in the Text box, type "A3". 4

It’s the cell from which you are going to extract characters.
> In the Num_chars text box, type "25". 5  You are specifying how 

many characters you want to extract from the end of the string. 
> Click OK. 6

> The result of the function is displayed in cell D3. 7

The RIGHT function
Let's extract characters from the end of a text string. To do that, use the RIGHT function. 

6

4

5

7

Try to extract Lisa's 
email from cell A4.

3

1

2
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The SUBSTITUTE function
If you want to replace part of the text in a cell, use the SUBSTITUTE function.

To use the SUBSTITUTE function:

> Click in cell A5. 1

> On the Formulas tab, in the Function Library group, click Text. 2

> In the list, click SUBSTITUTE. 3

> In the Function Arguments window, in the Text box, type "A3". 4  It’s the 
cell that contains the part of the text you are going to replace. 

> In the Old_text box, type "phone". 5  This is the word you want to change. 
> In the New_text box, type "telephone". 6  This is the new word. 
> Click OK. 7

> The result of the function is displayed in cell A5. 8

3

1

4

5

6

7

8

2

Hands on!
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1. Read the following sentences and put a check mark for True or False.

True False

1. The "LEFT" function in Excel takes the first part of a word or 
code from the left side. 

2. If you want to find half of a number, you use the "POWER" 
function in Excel. 

3. The "RIGHT" function in Excel can help you extract a word or 
code's last letters or numbers. 

4. The "MID" function in Excel can only extract letters from the 
beginning of a word. 

5. A key part of the data cleaning process is removing 
duplicates.

2. Read the questions and put a check mark for the correct answer.

1. Which function would you use to extract the last two letters of the word "APPLE"?

 a. LEFT

 b. MID

 c. RIGHT

 d. None of the above

2. If you want to extract the first three letters from a word in Excel, which function do you 
use?

 a. RIGHT

 b. LEFT

 c. POWER

 d. MID

35
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3. Which function can you use to get the second and the third letters in the word 
"BEACH"?

 a. MID

 b. LEFT

 c. RIGHT

 d. POWER

4. In the following table, if you want to calculate the percentage of rainy days, which 
formula would you use as a first step?

 a. A1/B1

 b. =A2+B2 

 c. =A2/B2

 d. =A1/A2

3. You have a list of file names, such as Report.docx, Photo.jpeg, and Present.ppt. Which 
function could you use to extract the file type (or extension)? Explain how identifying file 
types could be helpful if you’re sorting or organizing many files.

4. Open a new spreadsheet and type this sentence: "The employee code is EMP-12345-USA". 
Next, you should: 

• Use the appropriate functions to replace "EMP" with "STAFF". 

• Extract the country and the number in different cells.

5. Your school did some research to find out which is the most interesting subject to 
students. The questionnaire below displays the votes for each subject. Now, using 
Microsoft Excel, type the text and numbers as they are in the worksheet. Calculate the 
total number of votes and the percentage of votes for each subject. Fill the empty cells 
with the appropriate formulas and format the cells B4:F4 as percentages.
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A cell takes its name from the column letter and row number to which it belongs. A cell reference is 
the "address" of the cell and identifies its location. In some cases, you may want to use the same 
formula in different places on your spreadsheet. Copying the formula helps you work faster and 
analyze the data accurately. When you want to copy the same formula to new cells, you can use 
relative and absolute references. 

Relative reference
Relative reference is the cell reference. When you copy a cell that has a formula, the formula 
changes automatically. The change depends on the relative position of rows and columns. 

Absolute reference
Sometimes you want to keep a cell, a row, or a column constant when copying a formula. You have 
to declare this when you create the formula by using the $ (dollar sign). This way, you create an 
absolute reference which doesn’t change when it’s copied or "filled." 

LESSON 4

References

What happens when you drag a formula to other cells using 
AutoFill? Does the formula remain the same? What could 
you do if you would like to use the same cell in a formula?

Τype the contents of 
columns A and B and in 
cell C2, type "=A2*B2".

If you copy the formula 
=A2*B2 to cell C3, it will 

become =A3*B3.
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For example, type the contents of columns A and B below and in cell C2, type "=$D$1*B2".

Types of cell referencing

Reference type Reference action

$E$1 The cell doesn’t change when it is copied. Both the column and the row 
remain the same.

$E1 The row changes when it is copied, but the column remains the same.

E$1 The column changes when it is copied, but the row remains the same.

If you apply the formula =$D$1*B2 
to column C, the formula will 
change to become =$D$1*B3, 

=$D$1*B4, etc.

Notice that when the number of 
the row changes, the cell that 

has the $ signs stays the same.

Smart Tip
You can use the Copy and Paste commands as well, instead of the AutoFill feature.
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Create the following table:

A way to remember how to use 
the dollar sign is to think about 

how you want to use the Auto Fill
feature. If you want to use it 

horizontally, then type the dollar 
sign in front of the letter (column). 
If you want to use it vertically, type 

it in front of the number (row).

To create and copy a formula using references:

> Click in cell H4. 1

> In the Formula bar, type the formula "=G4*$G$1". 2

> Press  +  to calculate the formula and 
stay in the same cell. 3

> Use the Auto Fill feature to copy the formula. 4

1

2

3

4
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To create and copy a 
formula using 
row absolute reference: 

> Create this table and 
click in cell E2. 1

>  In the Formula bar, type 
"=D2*B$8". 2

>  Press  +  to 
calculate the formula and 
stay in the same cell. 3

>  Use the Auto Fill feature 
to copy the formula. 4

1

2

3

4

You can click the cell 
you want to lock and 
press  to apply an 
absolute reference.

40 For Review Purposes Only 



To create and copy a formula using column absolute reference: 

> Create this table and click in cell B5. 1

> In the Formula bar, type "=B4*$I1". 2

> Press  +  to calculate the formula and stay in the 
same cell. 3

> Use the Auto Fill feature to copy the formula. 4

1

2

3

4
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IF and references
You are going to combine the IF function with an absolute reference. Before you start, let’s find the 
Total value, which is the Value minus the Discount, in column F, and find the Average value in cell F8.

If the Total value is more than the Average value, then it is above average. If it is less (ELSE), then it 
is below average.

To use IF with a reference:

> Click in cell G2. 1

> On the Formulas tab, in the Function Library group, click Insert Function. 2

> In the Insert Function window, in the Or select a category list, click All. 3

> Click IF, 4  and then click OK. 5

> In the Function Arguments window, type "F2>$F$8" in the Logical_test text box. 6

> In the Value_if_true text box, type "Above Average". 7

> In the Value_if_false text box, type "Below Average". 8

> Click OK. 9

> Use the Auto Fill feature to copy the function. 10

1

2
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Common error messages
If you happen to make a mistake when typing a formula, you will receive an error message on the 
worksheet.

You can correct the mistake by clicking the button that is located next 
to the cell that displays the message and choosing Edit in Formula Bar.

Most common error messages

Error code Error explanation

######
You will get this error message when a column with numerical data is not wide 
enough to display all of its content. You can correct it by increasing the width of 
the column to fit everything correctly.

#DIV/0! You will get this error message when you divide something by 0. You can correct 
it by changing the divisor in the function or formula so it is not 0 or blank.

#NAME?
You will get this error message when you have typed an incorrect formula, and 
Microsoft Excel cannot recognize it. You can correct it by typing the formula’s 
correct name.

#VALUE!
You will get this error message when a mathematical formula includes cells that 
contain text as well as numbers. You can correct it by removing references to 
cells containing text. In the example above, cell B10 displays this error.

Change the discount in cell B8 to 20, and notice the 
changes in your data. What changes have been made 

to your data? Did references help you with that?

Hands on!
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1. Read the following sentences and put a check mark for True or False

True False

1. A cell reference is the "address" of the cell and identifies its 
location. 

2. When using a relative reference, the formula changes 
automatically based on the position of rows and columns. 

3. The error message #DIV/0! occurs when dividing by zero. 

4. The #NAME? error is displayed if you use a formula name 
incorrectly in Excel. 

5. Absolute references change when copied to other cells. 

6. When you use the dollar sign in front of a letter and in front 
of a number (e.g., $E$1) the row and the column remain the 
same.

2. Read the questions and put a check mark for the correct answer.

1. Which symbol is used to create an absolute reference in Excel?

 a. %

 b. #

 c. $

 d. !

45
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2.	 Which error indicates a cell is too narrow to display all its contents?

	 a. #DIV/0!

	 b. ######

	 c. #NAME?

	 d. #VALUE!

3.	 Which error occurs when a column with numerical data is not wide enough to display all 
of its content?

	 a. #VALUE!

	 b. #NAME?

	 c. #DIV/0!

	 d. ######

4.	 If you want a column to remain constant, where should you place the $ sign?

	 a. Before the column letter

	 b. Before the row number

	 c. Both before the column letter and row number

	 d. Between the letter and the number of the cell's name

5.	 Which of these functions would create an absolute reference for cell D1?

	 a. $D$1

	 b. D1$

	 c. D1

	 d. D1_$

6.	 Which error is displayed when a mathematical formula includes cells that contain text as 
well as numbers?

	 a. #NAME?

	 b. #VALUE!

	 c. ######

	 d. #DIV/0!
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3. How can you apply tax across multiple items? Would it be more helpful to do that using 
absolute references? Describe what could go wrong when using an absolute reference.

4. Create the following table and fill in the cells with the appropriate function. In cells I4:I10, 
remember to use a function with an absolute reference.

5. Create the table below and use formulas to fill in the cells. In column G, add the sales 
from January to May for each person using a relative reference. In column H, calculate 
the bonus for each person. The bonus is 10% of their total sales. Use an absolute 
reference for the 10%, which is in cell B10.
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Chart types
To make data presentations more engaging and informative, charts can be used. There are various 
types of charts to choose from, but it is important to select the most effective one for the specific 
purpose. Choosing the wrong chart could lead to confusion or misinterpretation of the data.

The Column or Bar Chart is 
used to illustrate comparisons 
between a series of data. In a 
column chart, categories are 

horizontal (X-axis) and numeric 
values are vertical (Y-axis). The 

opposite happens in a bar 
chart, which is one of the most 

commonly used chart types.

The Line Chart is used to 
display trends. It presents the 
changes in data over a period 
of time. Numeric values are 
always vertical (Y-axis) and 
time horizontal (X-axis). It is 

suitable for presenting data for 
a large number of groups.

The Area Chart is like a Line 
Chart, except the area below 

the plotted line is filled in with 
color. It is used to display 

trends over time or some other 
category, and it is suitable for 
presenting data for a limited 

number of groups.

The Pie Chart is used to 
display only one series of data. 
It presents the relationship of 

the parts to the whole. 
It is suitable for presenting 

data for one group.

The Scatter Chart is used to 
display the values of two series 
and compare them over time. It 
is like a Line Chart, except the 

plotted line presents data 
points. It is suitable for 

presenting the relationship 
between two variables.

The Doughnut Chart
is used to display data as 

doughnut slices and is similar 
to the Pie Chart.

LESSON 5

Advanced charts

In which cases could a visual representation of 
your data give you a more accurate analysis?

48 For Review Purposes Only 



To add a chart: 

> Create this table and select cells 
A2 to C10. 1

> On the Insert tab, in the Charts
group, click Insert Column or 
Bar Chart. 2

> In the list of column chart sub-
types, click the one you like. 3

> The chart will be added to your 
worksheet. 4

1

2

3

4
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To move the chart:

> Click on the chart. 1

> On the Chart Design tab, in the Location group, click Move Chart. 2

> On the Move Chart window, select New sheet to move your chart to a new worksheet. 3

> Click OK. 4

1

2

3

4

You can choose to have 
your chart on a new 

sheet. In that case, your 
chart will take up the 
whole spreadsheet.

Use Object in to move your 
chart to an existing worksheet.
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Use Centered Overlay 
when you want to 

center the title over the 
chart, but don’t want to 
change the size of the 

chart. 

Modifying a chart
After you create a chart, you can modify it. For instance, you may want to change its titles or its type.

To change the title:

> Click on the chart. 1

> On the Chart Design tab, in the Chart Layouts group, click Add Chart Element. 2

> Click Chart Title and then click Centered Overlay. 3

> Double-click on the chart title, delete the text, and type "Statistics". 4

> Click anywhere outside the chart title.

Use More Title Options 
when you want more 
options about filling, 

line style, etc.

Use None if you 
don’t want a title.

1

2

3

4
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1

2

3

4

To change the format of an axis:

> Click on the chart. 1

> On the Chart Design tab, in the Chart Layouts group, click Add Chart Element. 2

> In the Axis Titles pop-out menu, click Primary Horizontal. 3

> Double-click on the horizontal axis title, delete the text, and type "Teams". 4

> Click anywhere outside the horizontal axis title.
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To change the Shape Fill of the chart: 

> Click on the bars you want to make changes to, e.g., those that 
represent the losses. 1

> On the Format tab, in the Shape Styles group, click Shape Fill. 2

> Click on a color of your choice. 3

Coloring a chart
You can make your charts more attractive in Excel by changing the colors and fills of different chart 
parts. You can use regular colors, apply textures, or even fill shapes with pictures. This helps make 
your data clearer and easier to understand.

1

2

3
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Use Texture when you 
want to use a texture fill. 

Use More Fill Colors 
when you want to fill the 
shape with a color that is 

not available in the 
Theme Colors list. 

Use Gradient when you 
want to fill the shape 

with a color that changes 
from light to dark.

Use Picture when you 
want to fill the shape 

with a picture. 
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Mini charts (Sparklines)
At times, a simple graphical representation of data within a table is needed. This can be achieved 
with mini charts. Mini charts (sparklines) are small versions of regular charts, placed next to the data 
for clear visualization.

To add a mini chart:

> Select the cells where you want your mini chart to be displayed, e.g., select 
cells D3 to D10. 1

> On the Insert tab, in the Sparklines group, click Line. 2

> In the Create Sparklines window, in the Data Range box, type "B3:C10". 3

These cells contain the data you want to represent in a mini chart.
> Click OK. 4

1

2

3

4
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To modify a mini chart:

> Select from cell D3 to cell D10, where the mini chart is. 1

> On the Sparkline tab, in the Style group, click Sparkline
Color 2  and click on a color of your choice. 3

You can also click 
Marker Color to 

color your markers.

Smart Tip
Mini charts are created in small spaces, so be careful not to use unnecessary formatting.

1

2

3

 The sparklines in 
column D depict the 
performance trends 

for each team by 
showing their wins 

and losses in a 
compact line graph.
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Conditional formatting
Conditional formatting allows you to change the layout of cells based on their content. By 
specifying certain conditions, the cell's formatting will automatically adjust to meet those conditions.

To apply Conditional Formatting:

> Select the cells where you want to apply conditional formatting, e.g., B3 to C10. 1

> On the Home tab, in the Styles group, click Conditional Formatting. 2

> Click New Rule. 3

> You can select the criteria you want to use, e.g., click Format only cells that contain. 4

> Type "10" and "20". 5

> Click the Format button 6  and format the cells accordingly. 
> Click OK. 7

1

2

3
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Use Format only 
cells that contain
to create rules and 
format your cells 
based on these. 

4

5

6

7

If a value is 
between 10 and 
20, the cell color 
is filled with an 
orange color.
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Lab data collection
In a science lab, you can perform many different experiments. Some of these experiments 
involve taking measurements. Data loggers are specifically designed for this purpose. They 
are devices with sensors that help you measure and record data, such as light, sound, and 
temperature measurements. 

A data logger can take repeated measurements and then transfer the data to your computer 
for analysis. Just connect the data logger to the USB port of the computer and download the 
recorded data.

Displaying data as charts
With a data logger, you can capture and display real-time data continuously or at regular 
intervals over long periods of time. One kind of data logger is a weather station, which 
records everything about the current weather conditions. Scientists can then use this data to 
predict changes in the weather. Using data logging software, you can display the data as a 
chart.

After you take your measurements 
with a data logger, you can 

download the data to the data 
logger’s software on your computer.
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What can you do with a data logger?
1. Accurately measure sound and light as well as temperature.
2. Take measurements that are too slow or too fast to record by traditional means.
3. Collect data anywhere and then download the data to a computer for analysis.
4. Get visual representation of your measurements such as charts or graphs.

Experiment
Use a data logger to take measurements of temperature, light level, and sound level in different 
parts of your school. 

After analyzing this data, you will be able to answer questions like:

• Which is the hottest place in school?

• Which is the noisiest place in school?

• Which is the darkest place in school?

Let’s import our data to Microsoft Excel in order to analyze it and answer our questions.

To find the hottest 
place, e.g., you can 
sort your table by 
Temperature and 
check where the 

highest temperature 
was recorded.

To import your data:

> Using the data logger 
software, you should be 
able to display your data 
as a table by clicking the 
Display Table button. 1

> Select the values displayed 
in the table and copy them.

> Open Microsoft Excel and 
paste your data in a new 
worksheet. 2

1

2

Hands on!
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1. Read the following sentences and put a check mark for True or False.

True False

1. You can move a chart as an object only to an existing 
worksheet.

2. You can fill the shape in a chart with a picture.

3. To add a "Mini" chart next to a data table, you have to 
determine the data range and the location range.

4. When you change the title of a chart, the centered overlay 
operation changes the size of the title.

5. When you apply "Conditional formatting," you can create 
rule types that apply only to values in a certain range.

6. The "Pie" chart displays the changes in data over a period of 
time.

7. Data loggers are used to record only sound and 
temperature measurements.

8. By using a data logger, you can get visual representation of 
your measurements.

2. Complete with the missing words.

1. A Line Chart is used to display  over a period of time.

sensors chart trends "Add Chart Element"

"Centered Overlay"repeated

61
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2.  To change the title of a chart, click on the chart, go to the "Chart Design" tab, and click 

.

3.  Use  when you want to center the title over the chart, but don’t 

want to change the size.

4.  A data logger can take  measurements and then transfer the 

data to your computer for analysis.

5.  Data loggers are devices that use  to measure and record data, 

such as light and temperature.

6.  Scientists can use data logger software to display data as a  for 

analysis.

3. Imagine you are tracking the sales of different types of snacks over time, and you want to 
compare the changes in sales for each snack. Which chart type would you choose, and 
why? Explain how using the wrong chart type could confuse or create misleading data.

4. Create the following table. Add a pie chart and a column chart. Change the fill colors and 
the names of the axes in the chart.

Organizing and analyzing product inventory
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Project

Open a new spreadsheet and complete the following tasks:

1. Data setup
• Set up columns for Product Name, Category, Price, Stock Level, and Supplier. 

•  Create your own data for at least 10 products of your choice. Include the category (e.g., 
electronics, groceries), price, stock level, and supplier. Use the screenshot provided as a 
reference example.

2. Data organization
•  Format the data as a table. Next, sort the table by price to display products from the cheapest to 

the most expensive. 

•  Apply a filter to display only products within a specific category, such as electronics.

3. Using functions
•  Use the LEFT function to extract the first three letters of each product name. 

Set up a database to organize a list of products, including product names, categories, 
prices, stock levels, and supplier names.

Organizing and analyzing product inventory
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• Use the MID function to extract the middle part of each supplier's name. 

• Use the RIGHT function to extract the last two letters of each product category. 

• Use the SUBSTITUTE function to replace a word in the Category column (e.g., replace "Groceries" 
with "Food"). 

4. Advanced calculations
•  Create a formula to calculate a 10% tax on each product’s price using the appropriate references. 

•  Find the percentage of each product's stock level according to the total stock level. 

•  Create a column chart to display the stock levels of different products and a pie chart to display 
the percentages of products' stock levels. 
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Reflect

1. Which Excel feature did you find the most challenging to use, and how did you 
manage to use it efficiently?

2. How did using filters and sorting help you quickly locate information within your 
database?

3. How did creating charts help you recognize patterns or trends in your data that might not 
have been obvious from examining the numbers alone?

4. Reflecting on the project as a whole, how has learning to use Excel changed the way you 
think about managing information and making decisions based on data?
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Discover more
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Google Sheets
You can have a spreadsheet 
program in any platform. If you 
have a Google Android device, 
you can use Google Sheets.

Tap the menu and insert all the 
known functions or new rows 
and columns.

LibreOffice Calc
LibreOffice Calc is a free 
spreadsheet program that you 
can download from the Internet.

It has all the tools that you’ve 
learned in this module. Create 
charts, use formulas, and play 
with numbers.

Edit your tables and print them 
to present your data.

Apple Numbers for 
iPad OS
Apple Numbers will help you 
create your own tables and 
charts on an iPhone or iPad. 
The interface is similar to 
Microsoft Excel.

One difference you may notice 
is that the spreadsheet tabs 
are at the top of the window.

Take a moment to reflect on your progress.
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Wrap up
How confident are you in your ability to apply the following skills?
>  I can differentiate between data and information.
> I can create a simple database to organize information.
> I can apply filters to show only specific data in a database.
> I can sort data, including using multiple sorting levels, to organize it in a

helpful order.
> I can import and export data as CSV files.
> I can convert data into percentages, apply formatting, and calculate powers

using Excel functions.
> I can extract parts of strings using LEFT, RIGHT, and MID functions and

replace text with SUBSTITUTE.
> I can use relative and absolute references appropriately in formulas.
> I can identify the different types of charts and know when to use each one.
> I can create a chart in Excel and add titles, labels, and colors to make it clear

to understand.
> I can add sparklines to a worksheet to show data trends in a compact way.

Key Terms
absolute reference

area chart

bar chart

column chart

conditional formatting

CSV

database

doughnut chart

error message

export

formula

gradient

import

LEFT

line chart

MID

mini chart

percentage

pie chart

POWER

relative reference

RIGHT

scatter chart

sparkline

SUBSTITUTE

Take a moment to reflect on your progress.

67For Review Purposes Only 




